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Getting Started Creating a new
project

Recording media

Editing a project Configuring object
properties

Exporting your
project

 Home > Overview

Overview
 

Online Help 

 

Welcome to the ScreenToVideo online help system. Browse through the help pages by clicking
on the icons below or selecting pages in the table of contents to the left. To quickly find
specific product information, enter search criteria in the search box above and click the search
button. 

If you're unable to find what
you're looking for in this help
system, please contact our
support team:
support@screentovideo.com
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  Home > Getting Started

Getting Started
 
Creating a video presentation is typically a three‐step process:

Recording your media
Editing the recording
Exporting the project as a video file

 
This guide is designed to introduce you to using ScreenToVideo, all of its features, functions, and tools.
The guidelines in this help file will take you through the features of the application and lead you through the
process of creating a video presentation.

See also
Overview
Creating a new project
Recording media
Editing a project
Configuring object properties
Exporting your project
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System Requirements
 

Operating System: Microsoft Windows 10 / 8  / 7  ﴾Required: 64 Bit versions only﴿
Processor ﴾CPU﴿: Intel Core™ i‐series or AMD Phenom® II and above
Screen Resolution:1024 x 768, 32‐bit color or above
Hard Disk Space: 20MB for product installation
Memory: Minimum 2 GB RAM

See also
Installing
User interface
Trial mode
Activating your license
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  Home > Getting Started > Installing

Installing
 
Please follow the steps below to install ScreenToVideo:

See also
System Requirements
User interface

Download a fully‐functional version of ScreenToVideo free for a 15‐day trial period.1

After downloading the file, run 'svsetup.exe' file. 2

The Welcome window will appear. Click the Next button to continue. 3

License Agreement: 
If you accept the terms click 'I accept the agreement' and the Next button.

4

Choose the installation location: 
Enter the location where you want to install ScreenToVideo and click the Next button.

5

Click the Install button to continue with the installation.6

Check Launch ScreenToVideo to run ScreenToVideo after installation. Click the Finish button to complete the installation. 7

4 . Getting Started
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Trial mode
Activating your license
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  Home > Getting Started > User interface

User interface
 

 

See also
System Requirements
Installing
Trial mode
Activating your license
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Trial mode
 
Until you unlock ScreenToVideo by purchasing a license and activating it, ScreenToVideo operates in trial mode.
In trial mode, all of ScreenToVideo’s features are available, but your videos are watermarked when you export
them.

See also
System Requirements
Installing
User interface
Activating your license
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  Home > Getting Started > Activating your license

Activating your license
 
Please follow the steps below to register ScreenToVideo:

Start ScreenToVideo.1

Select Help > Enter License Key.2

Click Buy Now!.
This redirects you to the ScreenToVideo online store where you can purchase your license.
As soon as your order is processed, you will receive an e‐mail containing the registration key.

3

Enter the email/license key and click Register.
If the Register button is dimmed, it means that the license is invalid. Double‐check your license from the e‐mail. 

4
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See also
System Requirements
Installing
User interface
Trial mode
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  Home > Creating a new project

Creating a new project
 
Start creating a new project by selecting File > New Blank from the main menu. You should then see the
Create New Project window, which lets you choose the size of the project you want to create.

Select File > New Screen Recording from the main menu to create a project from screen recording.
 

See also
Overview
Getting Started
Recording media
Editing a project
Configuring object properties
Exporting your project
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Blank project
 
Create a blank project.

 

See also
Screen recording project
Webcam recording project
 
 
 

From the File menu select 'New Blank' or press Ctrl+N1

Select your preferred size for the project from preset sizes or manually enter required 'Width' and
'Height'

2

Finally, click 'Create' button at the bottom3
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  Home > Creating a new project > Screen recording project

Screen recording project
 
Create a screen recording project.

Full Screen
Presets
Recent Areas
Fit To Application

 For more details, please follow this link.

From the File menu select 'New Screen Recording' or press Ctrl+R1

Click the Screen button. 2

Click the dropdown to choose the screen area to record3

Click the dropdown to set how many frames per second are to be captured.
 Note that although a higher frame rate will result in larger file size, this will also make the playback
motion smoother.

 

4

Click the Record button or press Ctrl+F15

12 . Creating a new project
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The screen recording is added to the project.
 

 
Click the Timer button to display the countdown window.
By default, the countdown is set to 3 seconds. To change the countdown option, click the dropdown.

See also
Blank project
Webcam recording project
 
 
 

Click the Stop button or press Ctrl+F16
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  Home > Creating a new project > Webcam recording project

Webcam recording project
 
Create a webcam recording project.

From the File menu select 'New Screen Recording' or press Ctrl+R1

Click the Camera button2

The Webcam Preview window will appear 3

Click the dropdown to choose the camera device and the capture rate 

 

4

Click the Record button or press Ctrl+F15
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      The recording is added to the project.
 

 
Click the Timer button to display the countdown window.
By default, the countdown is set to 3 seconds. To change the countdown option, click the dropdown.

See also
Blank project
Screen recording project
 
 
 

Click the Stop button or press Ctrl+F16
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  Home > Recording media

Recording media
 
ScreenToVideo allows you to record:

Screen
Webcam
Microphone
System sound

See also
Overview
Getting Started
Creating a new project
Editing a project
Configuring object properties
Exporting your project
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  Home > Recording media > Screen

Screen
 
Record the computer screen:

Full Screen 

Presets

 
Recent Areas 

 
Fit To Application 

Click the  Screen Recording button from the toolbar1

Click the Screen button. 2

Click the dropdown to choose the screen area to record3
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 You can modify the size of the screen capture by clicking on the edges of the frame and manually dragging these

to give your required screen capture size or enter 'Width' and 'Height'.

 

 

The screen recording is added to the project at the playhead position.

 

 
Click the Timer button to display the countdown window.
By default, the countdown is set to 3 seconds. To change the countdown option, click the dropdown.

Click the dropdown to set how many frames per second are to be captured.
 Note that although a higher frame rate will result in larger file size, this will also make the playback
motion smoother.

 

4

Click the Record button or press Ctrl+F15

Click the Stop button or press Ctrl+F16

18 . Recording media
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See also
Webcam
Voice over narration
System sound
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  Home > Recording media > Webcam

Webcam
 
Record your webcam:

Click the  Screen Recording button from the toolbar1

Click the Camera button2

The Webcam Preview window will appear 3

Click the dropdown to choose the camera device and the capture rate 

 

4

Click the Record button or press Ctrl+F15
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      The recording is added to the project at the playhead position.
 

 
Click the Timer button to display the countdown window.
By default, the countdown is set to 3 seconds. To change the countdown option, click the dropdown.

See also
Screen
Voice over narration
System sound
 
 
 

Click the Stop button or press Ctrl+F16
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  Home > Recording media > Voice over narration

Voice over narration
 
Record audio from any microphone connected to your computer:

      The recording is added to the project at the playhead position.
 

 
Click the Timer button to display the countdown window.
By default, the countdown is set to 3 seconds. To change the countdown option, click the dropdown.

See also
Screen
Webcam
System sound
 
 
 

Click the  Screen Recording button from the toolbar1

Click the Microphone button2

Click the dropdown to select the microphone device3

Click the Record button or press Ctrl+F14

Click the Stop button or press Ctrl+F15
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  Home > Recording media > System sound

System sound
 
Record all sounds played through your computer:

      The recording is added to the project at the playhead position.
 

 
Click the Timer button to display the countdown window.
By default, the countdown is set to 3 seconds. To change the countdown option, click the dropdown.

See also
Screen
Webcam
Voice over narration
 
 
 

Click the  Screen Recording button from the toolbar1

Click the Sound button2

Click the dropdown to select the microphone device3

Click the Record button or press Ctrl+F14

Click the Stop button or press Ctrl+F15
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  Home > Editing a project

Editing a project
 

See also
Overview
Getting Started
Creating a new project
Recording media
Configuring object properties
Exporting your project
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  Home > Editing a project > Configuring project properties

Configuring project properties
 
Project properties can be edited by clicking on an empty space in the Timeline or on the Canvas.
In the Object Inspector, you can rename the project, edit its size and background.

Name
The default name for a project is 'Untitled X' ﴾'Untitled 1', 'Untitled 2', and so onward﴿, and this is visible in
the name property of the project. You can change the name by deleting the default name and typing in
another one.

1

Project size
Select this option in order to specify the new dimensions of your project.

Learn more...

Click the Reset button to reset all values.

Presets

Click the drop‐down box and choose a
preset size or select the Custom Size
menu item to enter custom dimensions.
Click on the Original Size menu item
to restore the project to its original size.

Size Enter Width and Height to specify the
size in pixels of your project.

Apply Click the Apply button to set the new
dimensions.

2

Background Fill
Set the background color of the project.

Learn more...

3

Editing a project . 25
 

ScreenToVideo



See also
Editing a project on the Canvas
Editing a project on the Timeline
 
 
 

Brush

Click to choose Solid Color | Linear
Gradient | Radial Gradient from the
popup menu.
For solid color, click the thumb and
select a color from the menu. Right
click on the thumb to set the opacity ﴾0
to 100%﴿.
For gradient, click in the left thumb
and select a color, then click in the
right thumb and select the second
color.

Opacity Use the slider to set the opacity value
or enter it manually ﴾0 to 100%﴿.

26 . Editing a project
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  Home > Editing a project > Editing a project on the Canvas

Editing a project on the Canvas
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  Home > Editing a project > Editing a project on the Timeline

Editing a project on the Timeline
 

 

See also
Configuring project properties
Editing a project on the Canvas
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  Home > Configuring object properties

Configuring object properties
 
The following tools are available and can be found in the toolbar. Click on an item below to view full details:

Screen recording
Image
Video
Audio
Shape
Text
Sketch animation
Video effect
Zoom area
Video transition
Text‐to‐speech
Voice over narration

See also
Overview
Getting Started
Creating a new project
Recording media
Editing a project
Exporting your project
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Screen recording
 
Screen recording properties can be edited by clicking on the screen recording in the Timeline or on the Canvas.
In the Object Inspector, you can rename the object, edit its size, effect, border and so on.

Name
The default name for a screen recording is 'Screen Recording X' ﴾'Screen Recording 1', 'Screen Recording
2', and so onward﴿, and this is visible in the name property of the object. You can change an object's
name by deleting the default name and typing in another one.

1

Placement & Opacity
Adjust the size, rotational angle, scale, opacity or manually change the location of the object on the
Canvas.

Learn more...

2
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Click the Reset button to reset all values.

Position

Enter X and Y coordinates to specify
the location in pixels of your object on
the Canvas, based on the center of the
object.

Size Enter Width and Height to specify the
size in pixels of your object.

Rotation Use the rotation option to rotate ﴾in
degrees: ‐180 to180﴿ the object.

Scale Use the scale option to scale ﴾10% to
200%﴿ the object.

Opacity

Use the slider to set the opacity value
or enter it manually ﴾0 to 100%﴿.
When set to zero, the object is
transparent.

Mask
The mask property allows you to change the shape of the screen recording: Rectangle, Circle, Ellipse,
Triangle, Hexagon, Octagon.

Learn more...

Adjust ﴾
Rectangle/Triangle﴿: Use
the slider to adjust the
roundness of the corners.

3

Media
Set the scale, opacity of the screen recording.

Learn more...

4
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Scale Click to scale the screen recording. 

Flip
This property allows you to flip the
screen recording vertically or
horizontally.

Opacity

Use the slider to set the opacity value
or enter it manually ﴾0 to 100%﴿. When
set to zero, the screen recording is
invisible.

Zoom & Pan
This feature allows you to focus your audience's attention on key aspects of your screen recording.

Learn more...

Zoom
Drag the slider to select the zoom
percentage or enter it manually ﴾100
to 500%﴿.

Left/Top Use the sliders to drag the screen
recording to the desired location.

5

Chroma‐Key
The Chroma‐Key creates transparency using a color.

Learn more...

Color

Click to specify the color to be
converted to transparency.
Use the color picker to select a color
on the screen
Set Invert to hide everything except
the color.

Tolerance
Use the slider to specify how far from
the chroma key color is considered
transparency.

6

Color Adjustment7
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This feature allows adjustment of brightness, contrast, and saturation.

Learn more...

Brightness Drag the slider to set the brightness
or enter it manually ﴾‐100 to 100%﴿.

Contrast Use the slider to set the contrast or
enter it manually ﴾‐25 to 200%﴿.

Saturation Use the slider to set the value or
enter it manually ﴾0 to 100%﴿.

Cursor
Cursor.

Learn more...

Scale Drag the slider to set the scale or enter it
manually ﴾100 to 500%﴿.

Name
Select Highlight | Magnify | Fisheye
Lens from the popup menu to create a
visual effect to the cursor. 

Color Click the color field to select the
highlight color from the popup menu.

Opacity Use the slider to set the value or enter
it manually ﴾0 to 100%﴿.

Radius Use the slider to set the radius or enter
it manually ﴾0 to 300 pixels﴿.

8
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Name
Select Rings | Ripple from the popup
menu to create a visual effect when
you left‐click the mouse.

Opacity Use the slider to set the opacity or
enter it manually ﴾0 to 100%﴿.

Radius Use the slider to set the value or enter
it manually ﴾0 to 300 pixels﴿.

Thickness Use the slider to set the value or enter
it manually ﴾1 to 10 pixels﴿.

Duration Use the slider to set the value or enter
it manually ﴾100 to 1000 ms﴿.

Volume Use the slider to set the volume value
or enter it manually ﴾0 to 200%﴿.

Name
Select Rings | Ripple from the popup
menu to create a visual effect when
you right click the mouse.

Opacity Use the slider to set the opacity or
enter it manually ﴾0 to 100%﴿.

Radius Use the slider to set the value or
enter it manually ﴾0 to 300 pixels﴿.

Thickness Use the slider to set the value or
enter it manually ﴾1 to 10 pixels﴿.

Duration Use the slider to set the value or
enter it manually ﴾100 to 1000 ms﴿.

Volume Use the slider to set the volume value
or enter it manually ﴾0 to 200%﴿.

Effect
Add an effect to a screen recording: Gaussian Blur, Directional Blur, Radial Blur, Spin Blur, Colorize,

9
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Grayscale, Pixelate, Dissolve, Genie, Magnify, Swirl, Fisheye Lens.

Learn more...

Use the slider to set the
intensity value or enter
it manually ﴾0 to 100%﴿.
Check the Border box to
clamp the output to the
size of the screen
recording.

Border
Add a border.

Learn more...

10
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Brush

Click to choose Solid Color | Linear
Gradient | Radial Gradient from the
popup menu.
For solid color, click the thumb and
select a color from the menu. Right
click on the thumb to set the opacity
﴾0 to 100%﴿.
For the gradient, click in the left
thumb and select a color, then click in
the right thumb and select the
second color.

Style

Describes the sequence of dashes
and gaps: Solid, Dash, Dot, Dash Dot,
Dash Dot Dot.
Describes the shape at the end of a
line or segment: Flat, Square, Round,
Triangle.

Thickness The border width ﴾in pixels: 1 to 20﴿.

Offset In pixels: ‐50 to 50.

Blur Size The amount of blur to be applied to
the border ﴾in pixels: 0 to 20﴿.

Opacity

Use the slider to set the opacity value
or enter it manually ﴾0 to 100%﴿.
When set to zero, the border is
invisible.

Drop Shadow
Create a shadow effect.

Learn more...

11
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Color Click the color field to select the
shadow color from the popup menu.

Blur
Size

The amount of blur to be applied to the
shadow ﴾in pixels: 0 to 50﴿ .

Offset
The distance between the screen
recording and the shadow ﴾in pixels: 0
to 300﴿.

Angle
The angle of the shadow relative to the
screen recording ﴾in degrees: ‐180 to
180﴿.

Opacity
Use the slider to set the opacity value
or enter it manually ﴾0 to 100%﴿. When
set to zero, the shadow is invisible.

Transition In
Transitions are applied to a screen recording to create a smooth progression into.
The following transitions are included: Custom, Circle Open, Circle Close, Rectangle Open, Rectangle
Close, Reveal, Slide, Radial Blur, Spin Blur, Pixelate, Dissolve, Genie, Swirl, Magnify, Fisheye Lens.

Learn more...

Click the Preview button to preview the transition on
the Canvas.
Click the Easing Function button to specify the rate
of change of a parameter over time.
Configure the transition properties ﴾Movement, Blur
Size, Scale, Fade, Spin, etc.﴿ using the controls
displayed on the bottom of the panel.

12

Transition Out
Used to determine how a screen recording exits.
The following transitions are included: Custom, Circle Open, Circle Close, Rectangle Open, Rectangle
Close, Wipe, Slide, Radial Blur, Spin Blur, Pixelate, Dissolve, Genie, Swirl, Magnify, Fisheye Lens.

Learn more...

13
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See also
Image
Video
Audio
Shape
Text
Sketch animation
Video effect
Zoom area
Video transition
Text‐to‐speech
Voice over narration
 
 
 

Click the Preview button to preview the transition on
the Canvas.
Click the Easing Function button to specify the rate
of change of a parameter over time.
Configure the transition properties ﴾Movement, Blur
Size, Scale, Fade, Spin, etc.﴿ using the controls
displayed on the bottom of the panel.
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  Home > Configuring object properties > Image

Image
 
Image properties can be edited by clicking on the image in the Timeline or on the Canvas.
In the Object Inspector, you can rename the image, edit its size, effect, border and so on. 

Name
The default name for an image is 'Image X' ﴾'Image 1', 'Image 2', and so onward﴿, and this is visible in the
name property of the object. You can change an image's name by deleting the default name and typing in
another one.

1

Placement & Opacity
Adjust the size, rotational angle, scale, opacity or manually change the location of the object on the
Canvas.

Learn more...

2
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Click the Reset button to reset all values.

Position

Enter X and Y coordinates to specify
the location in pixels of your object on
the Canvas, based on the center of the
object.

Size Enter Width and Height to specify the
size in pixels of your object.

Rotation Use the rotation option to rotate ﴾in
degrees: ‐180 to180﴿ the object.

Scale Use the scale option to scale ﴾10% to
200%﴿ the object.

Opacity

Use the slider to set the opacity value
or enter it manually ﴾0 to 100%﴿.
When set to zero, the object is
transparent.

Mask
The mask property allows you to change the shape of the image: Rectangle, Circle, Ellipse, Triangle,
Hexagon, Octagon.

Learn more...

Adjust ﴾
Rectangle/Triangle﴿: Use
the slider to adjust the
roundness of the corners.

3

Media
Set the scale, opacity of the image.

Learn more...

4
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Scale Click to scale the image. 

Flip This property allows you to flip the
image vertically or horizontally.

Opacity
Use the slider to set the opacity value
or enter it manually ﴾0 to 100%﴿. When
set to zero, the image is invisible.

Zoom & Pan
This feature allows you to focus your audience's attention on key aspects of your image.

Learn more...

Zoom
Drag the slider to select the zoom
percentage or enter it manually ﴾100
to 500%﴿.

Left/Top Use the sliders to drag the image to
the desired location.

5

Chroma‐Key
The Chroma‐Key creates transparency using a color.

Learn more...

Color

Click to specify the color to be
converted to transparency.
Use the color picker to select a color
on the screen
Set Invert to hide everything except
the color.

Tolerance
Use the slider to specify how far from
the chroma key color is considered
transparency.

6

Color Adjustment
This feature allows adjustment of brightness, contrast, and saturation.

7
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Learn more...

Brightness Drag the slider to set the brightness
or enter it manually ﴾‐100 to 100%﴿.

Contrast Use the slider to set the contrast or
enter it manually ﴾‐25 to 200%﴿.enter it manually ﴾‐25 to 200%﴿.

Saturation Use the slider to set the value or
enter it manually ﴾0 to 100%﴿.

Effect
Add an effect to an image: Gaussian Blur, Directional Blur, Radial Blur, Spin Blur, Colorize, Grayscale,
Pixelate, Dissolve, Genie, Magnify, Swirl, Fisheye Lens.

Learn more...

Use the slider to set the
intensity value or enter
it manually ﴾0 to 100%﴿.
Check the Border box to
clamp the output to the
size of the image.

8

Border
Add a border.

Learn more...

9
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Brush

Click to choose Solid Color | Linear
Gradient | Radial Gradient from the
popup menu.
For solid color, click the thumb and
select a color from the menu. Right
click on the thumb to set the opacity
﴾0 to 100%﴿.
For the gradient, click in the left
thumb and select a color, then click in
the right thumb and select the
second color.

Style

Describes the sequence of dashes
and gaps: Solid, Dash, Dot, Dash Dot,
Dash Dot Dot.
Describes the shape at the end of a
line or segment: Flat, Square, Round,
Triangle.

Thickness The border width ﴾in pixels: 1 to 20﴿.

Offset In pixels: ‐50 to 50.

Blur Size The amount of blur to be applied to
the border ﴾in pixels: 0 to 20﴿.

Opacity

Use the slider to set the opacity value
or enter it manually ﴾0 to 100%﴿.
When set to zero, the border is
invisible.

Drop Shadow
Create a shadow effect.

Learn more...

10
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Color Click the color field to select the
shadow color from the popup menu.

Blur
Size

The amount of blur to be applied to the
shadow ﴾in pixels: 0 to 50﴿ .

Offset The distance between the image and
the shadow ﴾in pixels: 0 to 300﴿.

Angle The angle of the shadow relative to the
image ﴾in degrees: ‐180 to 180﴿.

Opacity
Use the slider to set the opacity value
or enter it manually ﴾0 to 100%﴿. When
set to zero, the shadow is invisible.

Transition In
Transitions are applied to an image to create a smooth progression into.
The following transitions are included: Custom, Circle Open, Circle Close, Rectangle Open, Rectangle
Close, Reveal, Slide, Radial Blur, Spin Blur, Pixelate, Dissolve, Genie, Swirl, Magnify, Fisheye Lens.

Learn more...

Click the Preview button to preview the transition on
the Canvas.
Click the Easing Function button to specify the rate
of change of a parameter over time.
Configure the transition properties ﴾Movement, Blur
Size, Scale, Fade, Spin, etc.﴿ using the controls
displayed on the bottom of the panel.

11

Transition Out
Used to determine how an image exits.
The following transitions are included: Custom, Circle Open, Circle Close, Rectangle Open, Rectangle
Close, Wipe, Slide, Radial Blur, Spin Blur, Pixelate, Dissolve, Genie, Swirl, Magnify, Fisheye Lens.

Learn more...

12
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See also
Screen recording
Video
Audio
Shape
Text
Sketch animation
Video effect
Zoom area
Video transition
Text‐to‐speech
Voice over narration
 
 
 

Click the Preview button to preview the transition on
the Canvas.
Click the Easing Function button to specify the rate
of change of a parameter over time.
Configure the transition properties ﴾Movement, Blur
Size, Scale, Fade, Spin, etc.﴿ using the controls
displayed on the bottom of the panel.
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  Home > Configuring object properties > Video

Video
 
Video properties can be edited by clicking on the video in the Timeline or on the Canvas.
In the Object Inspector you can rename the video, edit its size, effect, border and so on.

Name
The default name for a video is 'Video X' ﴾'Video 1', 'Video 2', and so onward﴿, and this is visible in the
name property of the object. You can change a video's name by deleting the default name and typing in
another one.

1

Placement & Opacity
Adjust the size, rotational angle, scale, opacity or manually change the location of the object on the
Canvas.

Learn more...

2
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Click the Reset button to reset all values.

Position

Enter X and Y coordinates to specify
the location in pixels of your object on
the Canvas, based on the center of the
object.

Size Enter Width and Height to specify the
size in pixels of your object.

Rotation Use the rotation option to rotate ﴾in
degrees: ‐180 to180﴿ the object.

Scale Use the scale option to scale ﴾10% to
200%﴿ the object.

Opacity

Use the slider to set the opacity value
or enter it manually ﴾0 to 100%﴿.
When set to zero, the object is
transparent.

Mask
The mask property allows you to change the shape of the video: Rectangle, Circle, Ellipse, Triangle,
Hexagon, Octagon.

Learn more...

Adjust ﴾
Rectangle/Triangle﴿: Use
the slider to adjust the
roundness of the corners.

3

Media
Set the scale, opacity of the video.

Learn more...

4
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Scale Click to scale the video. 

Flip This property allows you to flip the
video vertically or horizontally.

Opacity
Use the slider to set the opacity value
or enter it manually ﴾0 to 100%﴿. When
set to zero, the video is invisible.

Zoom & Pan
This feature allows you to focus your audience's attention on key aspects of your video.

Learn more...

Zoom
Drag the slider to select the zoom
percentage or enter it manually ﴾100
to 500%﴿.

Left/Top Use the sliders to drag the video to the
desired location.

5

Chroma‐Key
The Chroma‐Key creates transparency using a color.

Learn more...

Color

Click to specify the color to be
converted to transparency.
Use the color picker to select a color
on the screen
Set Invert to hide everything except
the color.

Tolerance
Use the slider to specify how far from
the chroma key color is considered
transparency.

6

Color Adjustment
This feature allows adjustment of brightness, contrast and saturation.

7
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Learn more...

Brightness Drag the slider to set the brightness
or enter it manually ﴾‐100 to 100%﴿.

Contrast Use the slider to set the contrast or
enter it manually ﴾‐25 to 200%﴿.

Saturation Use the slider to set the value or
enter it manually ﴾0 to 100%﴿.

Effect
Add an effect to a video: Gaussian Blur, Directional Blur, Radial Blur, Spin Blur, Colorize, Grayscale,
Pixelate, Dissolve, Genie, Magnify, Swirl, Fisheye Lens.

Learn more...

Use the slider to set the
intensity value or enter
it manually ﴾0 to 100%﴿.
Check the Border box to
clamp the output to the
size of the video.

8

Border
Add a border.

Learn more...

9
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Brush

Click to choose Solid Color | Linear
Gradient | Radial Gradient from the
popup menu.
For solid color, click the thumb and
select a color from the menu. Right
click on the thumb to set the opacity
﴾0 to 100%﴿.
For gradient, click in the left thumb
and select a color, then click in the
right thumb and select the second
color.

Style

Describes the sequence of dashes
and gaps: Solid, Dash, Dot, Dash Dot,
Dash Dot Dot.
Describes the shape at the end of a
line or segment: Flat, Square, Round,
Triangle.

Thickness The border width ﴾in pixels: 1 to 20﴿.

Offset In pixels: ‐50 to 50.

Blur Size The amount of blur to be applied to
the border ﴾in pixels: 0 to 20﴿.

Opacity

Use the slider to set the opacity value
or enter it manually ﴾0 to 100%﴿.
When set to zero, the border is
invisible.

Drop Shadow
Create a shadow effect.

Learn more...

10
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Color Click the color field to select the
shadow color from the popup menu.

Blur
Size

The amount of blur to be applied to the
shadow ﴾in pixels: 0 to 50﴿ .

Offset The distance between the video and the
shadow ﴾in pixels: 0 to 300﴿.

Angle The angle of the shadow relative to the
video ﴾in degrees: ‐180 to 180﴿.

Opacity
Use the slider to set the opacity value
or enter it manually ﴾0 to 100%﴿. When
set to zero, the shadow is invisible.

Transition In
Transitions are applied to a video to create a smooth progression into.
The following transitions are included: Custom, Circle Open, Circle Close, Rectangle Open, Rectangle
Close, Reveal, Slide, Radial Blur, Spin Blur, Pixelate, Dissolve, Genie, Swirl, Magnify, Fisheye Lens.

Learn more...

Click the Preview button to preview the transition on
the Canvas.
Click the Easing Function button to specify the rate
of change of a parameter over time.
Configure the transition properties ﴾Movement, Blur
Size, Scale, Fade, Spin, etc.﴿ using the controls
displayed on the bottom of the panel.

11

Transition Out
Used to determine how a video exits.
The following transitions are included: Custom, Circle Open, Circle Close, Rectangle Open, Rectangle
Close, Wipe, Slide, Radial Blur, Spin Blur, Pixelate, Dissolve, Genie, Swirl, Magnify, Fisheye Lens.

Learn more...

12
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See also
Screen recording
Image
Audio
Shape
Text
Sketch animation
Video effect
Zoom area
Video transition
Text‐to‐speech
Voice over narration
 
 
 

Click the Preview button to preview the transition on
the Canvas.
Click the Easing Function button to specify the rate
of change of a parameter over time.
Configure the transition properties ﴾Movement, Blur
Size, Scale, Fade, Spin, etc.﴿ using the controls
displayed on the bottom of the panel.
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  Home > Configuring object properties > Audio

Audio
 
This object enables you to import audio clips into your project.
Audio properties can be edited by clicking on the object in the Timeline. In the Object Inspector, you can set the
volume.

See also
Screen recording
Image
Video
Shape
Text
Sketch animation
Video effect
Zoom area
Video transition
Text‐to‐speech
Voice over narration
 

Name
The default name for a voice over is 'Audio  X' ﴾'Audio 1', 'Audio 2', and so onward﴿, and this is visible in
the name property of the object. You can change the name by deleting the default name and typing in
another one.

1

Volume Control

Learn more...

Use the slider to set the volume value or enter it
manually ﴾0 to 200%﴿.
Enter Fade In and Fade Out values to specify the
audio transitions ﴾in ms: 0 to 2000﴿.

2
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Shape
 
Shape properties can be edited by clicking on the shape in the Timeline or on the Canvas.
In the Object Inspector, you can rename the shape, edit its size, effect, border and so on.

Name
The default name for a shape is 'Shape X' ﴾'Shape 1', 'Shape 2', and so onward﴿, and this is visible in the
name property of the object. You can change the name by deleting the default name and typing in
another one.

1

Placement & Opacity
Adjust the size, rotational angle, scale, opacity or manually change the location of the object on the
Canvas.

Learn more...

2
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Click the Reset button to reset all values.

Position

Enter X and Y coordinates to specify
the location in pixels of your object on
the canvas, based on the center of the
object.

Size Enter Width and Height to specify the
size in pixels of your object.

Rotation Use the rotation option to rotate ﴾in
degrees: ‐180 to180﴿ the object.

Scale Use the scale option to scale ﴾10% to
200%﴿ the object.

Opacity

Use the slider to set the opacity value
or enter it manually ﴾0 to 100%﴿.
When set to zero, the object is
transparent.

Shape Type
The type property allows you to change the appearance of the shape: Rectangle, Circle, Ellipse, Triangle,
Hexagon, Octagon, Line.

Learn more...

Adjust ﴾
Rectangle/Triangle﴿: Use
the slider to adjust the
roundness of the
corners.

3

Background Fill
Set the color of the shape.

Learn more...

4
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Brush

Click to choose Solid Color | Linear
Gradient | Radial Gradient from the
popup menu.
For solid color, click the thumb and
select a color from the menu. Right‐
click on the thumb to set the opacity ﴾0
to 100%﴿.
For gradient, click in the left thumb
and select a color, then click in the
right thumb and select the second
color.

Opacity
Use the slider to set the opacity value
or enter it manually ﴾0 to 100%﴿. When
set to zero, the shape is invisible.

Effect
Add an effect to shape: Gaussian Blur, Directional Blur, Radial Blur, Spin Blur, Colorize, Grayscale, Pixelate,
Dissolve, Genie, Swirl, Fisheye Lens.

Learn more...

Use the slider to set the
intensity value or enter
it manually ﴾0 to 100%﴿.
Check the Border box to
clamp the output to the
size of the shape.

5

Border
Add a border to shape.

Learn more...

6
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Brush

Click to choose Solid Color | Linear
Gradient | Radial Gradient from the
popup menu.
For solid color, click the thumb and
select a color from the menu. Right‐
click on the thumb to set the opacity
﴾0 to 100%﴿.
For gradient, click in the left thumb
and select a color, then click in the
right thumb and select the second
color.

Style

Describes the sequence of dashes
and gaps: Solid, Dash, Dot, Dash Dot,
Dash Dot Dot.
Describes the shape at the end of a
line or segment: Flat, Square, Round,
Triangle.

Thickness The border width ﴾in pixels: 1 to 20﴿.

Offset In pixels: ‐50 to 50.

Blur Size The amount of blur to be applied to
the border ﴾in pixels: 0 to 20﴿.

Opacity

Use the slider to set the opacity value
or enter it manually ﴾0 to 100%﴿.
When set to zero, the border is
invisible.

Drop Shadow
Create a shadow effect.

Learn more...

7
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Color Click the color field to select the
shadow color from the popup menu.

Blur
Size

The amount of blur to be applied to the
shadow ﴾in pixels: 0 to 50﴿ .

Offset The distance between the shape and
the shadow ﴾in pixels: 0 to 300﴿.

Angle The angle of the shadow relative to the
shape ﴾in degrees: ‐180 to 180﴿.

Opacity
Use the slider to set the opacity value
or enter it manually ﴾0 to 100%﴿. When
set to zero, the shadow is invisible.

Transition In
Transitions are applied to shape to create a smooth progression into the video.
The following transitions are included: Custom, Circle Open, Circle Close, Rectangle Open, Rectangle
Close, Reveal, Slide, Radial Blur, Spin Blur, Pixelate, Dissolve, Genie, Swirl, Magnify, Fisheye Lens.

Learn more...

Click the Preview button to preview the transition on
the Canvas.
Click the Easing Function button to specify the rate
of change of a parameter over time.
Configure the transition properties ﴾Movement, Blur
Size, Scale, Fade, Spin, etc.﴿ using the controls
displayed on the bottom of the panel.

8

Transition Out
Used to determine how a shape exits.
The following transitions are included: Custom, Circle Open, Circle Close, Rectangle Open, Rectangle
Close, Wipe, Slide, Radial Blur, Spin Blur, Pixelate, Dissolve, Genie, Swirl, Magnify, Fisheye Lens.

Learn more...

9
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See also
Screen recording
Image
Video
Audio
Text
Sketch animation
Video effect
Zoom area
Video transition
Text‐to‐speech
Voice over narration
 
 
 

Click the Preview button to preview the transition on
the Canvas.
Click the Easing Function button to specify the rate
of change of a parameter over time.
Configure the transition properties ﴾Movement, Blur
Size, Scale, Fade, Spin, etc.﴿ using the controls
displayed on the bottom of the panel.
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Text
 
Text properties can be edited by clicking on the text in the Timeline or on the Canvas.
In the Object Inspector, you can rename the text, edit its size, effect, border and so on.

Name
The default name for a text is 'Text X' ﴾'Text 1', 'Text 2', and so onward﴿, and this is visible in the name
property of the object. You can change a text's name by deleting the default name and typing in another
one.

1

Placement & Opacity
Adjust the size, rotational angle, scale, opacity or manually change the location of the object on the
Canvas.

Learn more...

2
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Click the Reset button to reset all values.

Position

Enter X and Y coordinates to specify
the location in pixels of your object on
the Canvas, based on the center of the
object.

Size Enter Width and Height to specify the
size in pixels of your object.

Rotation Use the rotation option to rotate ﴾in
degrees: ‐180 to180﴿ the object.

Scale Use the scale option to scale ﴾10% to
200%﴿ the object.

Opacity

Use the slider to set the opacity value
or enter it manually ﴾0 to 100%﴿.
When set to zero, the object is
transparent.

Shape
The shape property allows you to change the appearance of the text background: Rectangle, Circle, Ellipse,
Triangle, Hexagon, Octagon.

Learn more...

Adjust ﴾
Rectangle/Triangle﴿: Use
the slider to adjust the
roundness of the
corners.

3

Background Fill
Set the color of the background.

Learn more...

4
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Brush

Click to choose Solid Color | Linear
Gradient | Radial Gradient from the
popup menu.
For solid color, click the thumb and
select a color from the menu. Right‐
click on the thumb to set the opacity ﴾0
to 100%﴿.
For gradient, click in the left thumb
and select a color, then click in the
right thumb and select the second
color.

Opacity
Use the slider to set the opacity value
or enter it manually ﴾0 to 100%﴿. When
set to zero, the background is invisible.

Text
Set the text.

Learn more...

5

Configuring object properties . 63
 

ScreenToVideo



Font
Select to choose a font face from the
list of fonts provided by your
system.

Color

Click to choose Solid Color | Linear
Gradient | Radial Gradient | Bitmap
from the popup menu.
For solid color, click the thumb and
select a color from the menu. Right‐
click on the thumb to set the opacity
﴾0 to 100%﴿.
For gradient, click in the left thumb
and select a color, then click in the
right thumb and select the second
color.
For bitmap, select an object
﴾image/video﴿ from the menu.

Size
Use the slider to set the size of the
text or enter it manually ﴾14 to 192
pixels﴿.

Style
Click the color field to select the
underline color from the popup
menu.

Outline

Use the slider to set the width of the
outline. Click the color field to select
the color of the outline from the
popup menu.

Alignment

Select alignment: Align Left | Align
Center | Align Right | Align Justify.
Click Word‐wrap to allow long
words to be able to break and wrap
onto the next line.

Text Layout
Set the text layout.

Learn more...
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Margin‐
L

Use the slider to set the left margin of
the text or enter it manually ﴾‐200 to
200 pixels﴿.

Path Line, Bezier curve, Circle, Ellipse, Spiral,
Sinusoidal.

Offset Use the slider to set the offset or enter
it manually ﴾‐100 to 100%﴿.

  

Text Animation
Texts can have animations to create a smooth progression into the video.
The following animations are included: Letter: Custom, Letter: Reveal, Letter: Slide, Line: Custom.

Learn more...

Click the Preview button to preview the animation on
the Canvas.
Click the Easing Function button to specify the rate
of change of a parameter over time.
Configure the animation properties ﴾Movement, Scale,
Fade, Spin, etc.﴿ using the controls displayed on the
bottom of the panel.

7

Effect
Add an effect: Gaussian Blur, Directional Blur, Radial Blur, Spin Blur, Colorize, Grayscale, Pixelate, Dissolve,
Genie, Magnify, Swirl, Fisheye Lens.

Learn more...

Use the slider to set the
intensity value or enter
it manually ﴾0 to 100%﴿.
Check the Border box to
clamp the output to the
size of the shape.

8

Configuring object properties . 65
 

ScreenToVideo



Border
Add a border.

Learn more...

Brush

Click to choose Solid Color | Linear
Gradient | Radial Gradient from the
popup menu.
For solid color, click the thumb and
select a color from the menu. Right‐
click on the thumb to set the opacity
﴾0 to 100%﴿.
For gradient, click in the left thumb
and select a color, then click in the
right thumb and select the second
color.

Style

Describes the sequence of dashes
and gaps: Solid, Dash, Dot, Dash Dot,
Dash Dot Dot.
Describes the shape at the end of a
line or segment: Flat, Square, Round,
Triangle.

Thickness The border width ﴾in pixels: 1 to 20﴿.

Offset In pixels: ‐50 to 50.

Blur Size The amount of blur to be applied to
the border ﴾in pixels: 0 to 20﴿.

Opacity

Use the slider to set the opacity value
or enter it manually ﴾0 to 100%﴿.
When set to zero, the border is
invisible.

9

Drop Shadow
Create a shadow effect.

Learn more...

10
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Color Click the color field to select the
shadow color from the popup menu.

Blur
Size

The amount of blur to be applied to the
shadow ﴾in pixels: 0 to 50﴿ .

Offset The distance between the object and
the shadow ﴾in pixels: 0 to 300﴿.

Angle The angle of the shadow relative to the
text ﴾in degrees: ‐180 to 180﴿.

Opacity
Use the slider to set the opacity value
or enter it manually ﴾0 to 100%﴿. When
set to zero, the shadow is invisible.

Transition In
Transitions are applied to a text to create a smooth progression into.
The following transitions are included: Custom, Circle Open, Circle Close, Rectangle Open, Rectangle
Close, Reveal, Slide, Radial Blur, Spin Blur, Pixelate, Dissolve, Genie, Swirl, Magnify, Fisheye Lens.

Learn more...

Click the Preview button to preview the transition on
the Canvas.
Click the Easing Function button to specify the rate
of change of a parameter over time.
Configure the transition properties ﴾Movement, Blur
Size, Scale, Fade, Spin, etc.﴿ using the controls
displayed on the bottom of the panel.

11

Transition Out
Used to determine how a text exits.
The following transitions are included: Custom, Circle Open, Circle Close, Rectangle Open, Rectangle
Close, Wipe, Slide, Radial Blur, Spin Blur, Pixelate, Dissolve, Genie, Swirl, Magnify, Fisheye Lens.

Learn more...

12
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See also
Screen recording
Image
Video
Audio
Shape
Sketch animation
Video effect
Zoom area
Video transition
Text‐to‐speech
Voice over narration
 
 
 

Click the Preview button to preview the transition on
the Canvas.
Click the Easing Function button to specify the rate
of change of a parameter over time.
Configure the transition properties ﴾Movement, Blur
Size, Scale, Fade, Spin, etc.﴿ using the controls
displayed on the bottom of the panel.
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Sketch animation
 
Sketch properties can be edited by clicking on the sketch in the Timeline or on the Canvas.
In the Object Inspector, you can rename the sketch, edit its size, animation, shadow and so on.

Name
The default name for a sketch is 'Sketch X' ﴾'Sketch 1', 'Sketch 2', and so onward﴿, and this is visible in the
name property of the object. You can change the name by deleting the default name and typing in
another one.

1

Placement & Opacity
Adjust the size, rotational angle, scale, opacity or manually change the location of the object on the
Canvas.

Learn more...

Click the Reset button to reset all values.

Position

Enter X and Y coordinates to specify
the location in pixels of your object on
the canvas, based on the center of the
object.

Size Enter Width and Height to specify the
size in pixels of your object.

Rotation Use the rotation option to rotate ﴾in
degrees: ‐180 to180﴿ the object.

Scale Use the scale option to scale ﴾10% to
200%﴿ the object.

Opacity

Use the slider to set the opacity value
or enter it manually ﴾0 to 100%﴿.
When set to zero, the object is
transparent.

2
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Sketch Animation
Set the animation of the sketch.
The following animations are included: Rectangle, Circle, Ellipse, Triangle, Hexagon, Octagon, Line, Check.

Learn more...

Type

Click to set the animation.
Adjust ﴾ Rectangle/Triangle﴿: Use the
slider to adjust the roundness of the
corners.

Brush

Click to choose Solid Color | Linear
Gradient | Radial Gradient from the
popup menu.
For solid color, click the thumb and
select a color from the menu. Right‐
click on the thumb to set the opacity
﴾0 to 100%﴿.
For gradient, click in the left thumb
and select a color, then click in the
right thumb and select the second
color.

Thickness
Use the slider to set the thickness
value or enter it manually ﴾in pixels: 1
to 20﴿.

Blur Size The amount of blur to be applied to
the sketch ﴾in pixels: 0 to 20﴿.

Flip .

Duration
Use the slider to set the duration
value or enter it manually ﴾in ms: 100
to 5000﴿.

3

Drop Shadow
Create a shadow effect.

Learn more...

4
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See also
Screen recording
Image
Video
Audio
Shape
Text
Video effect
Zoom area
Video transition

Color Click the color field to select the
shadow color from the popup menu.

Blur
Size

The amount of blur to be applied to the
shadow ﴾in pixels: 0 to 50﴿.

Offset The distance between the sketch and
the shadow ﴾in pixels: 0 to 300﴿.

Angle The angle of the shadow relative to the
sketch ﴾in degrees: ‐180 to 180﴿.

Opacity
Use the slider to set the opacity value
or enter it manually ﴾0 to 100%﴿. When
set to zero, the shadow is invisible.

Transition Out
Used to determine how a sketch exits.
The following transitions are included: Custom, Circle Open, Circle Close, Rectangle Open, Rectangle
Close, Wipe, Slide, Radial Blur, Spin Blur, Pixelate, Dissolve, Genie, Swirl, Magnify, Fisheye Lens.

Learn more...

Click the Preview button to preview the transition on
the Canvas.
Click the Easing Function button to specify the rate
of change of a parameter over time.
Configure the transition properties ﴾Movement, Blur
Size, Scale, Fade, Spin, etc.﴿ using the controls
displayed on the bottom of the panel.

5
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Text‐to‐speech
Voice over narration
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Video effect
 
Video Effect properties can be edited by clicking on the object in the Timeline or on the Canvas.
In the Object Inspector, you can rename the object, edit its size, shape, effect and so on.

Name
The default name for a video effect is 'Video Effect X' ﴾'Video Effect 1', 'Video Effect 2', and so onward﴿,
and this is visible in the name property of the object. You can change the name by deleting the default
name and typing in another one.

1

Placement & Opacity
Adjust the size, rotational angle, scale or manually change the location of the video effect on the Canvas.

Learn more...

Click the Reset button to reset all values.

Position

Enter X and Y coordinates to specify
the location in pixels of your object on
the canvas, based on the center of the
object.

Size Enter Width and Height to specify the
size in pixels of your object.

Rotation Use the rotation option to rotate ﴾in
degrees: ‐180 to180﴿ the object.

Scale Use the scale option to scale ﴾10% to
200%﴿ the object.

2

Shape
The shape property allows you to change the appearance of the object: Rectangle, Circle, Ellipse, Triangle,
Hexagon, Octagon.

Learn more...

3
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Adjust ﴾
Rectangle/Triangle﴿: Use
the slider to adjust the
roundness of the
corners.

Effect
Set an effect: Gaussian Blur, Directional Blur, Radial Blur, Spin Blur, Colorize, Grayscale, Pixelate, Magnify,
Swirl, Fisheye Lens.

Learn more...

Use the slider to set the
intensity value or enter it
manually ﴾0 to 100%﴿.
Check the Invert box to
apply the effect outside of
the object.

4

Border
Add a border to the object.

Learn more...

5
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See also
Screen recording
Image
Video
Audio
Shape
Text
Sketch animation
Zoom area
Video transition
Text‐to‐speech
Voice over narration
 
 

Brush

Click to choose Solid Color | Linear
Gradient | Radial Gradient from the
popup menu.
For solid color, click the thumb and
select a color from the menu. Right‐
click on the thumb to set the opacity
﴾0 to 100%﴿.
For gradient, click in the left thumb
and select a color, then click in the
right thumb and select the second
color.

Style

Describes the sequence of dashes
and gaps: Solid, Dash, Dot, Dash Dot,
Dash Dot Dot.
Describes the shape at the end of a
line or segment: Flat, Square, Round,
Triangle.

Thickness The border width ﴾in pixels: 1 to 20﴿.

Offset In pixels: ‐50 to 50.

Blur Size The amount of blur to be applied to
the border ﴾in pixels: 0 to 20﴿.

Opacity

Use the slider to set the opacity value
or enter it manually ﴾0 to 100%﴿.
When set to zero, the border is
invisible.
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Zoom area
 
Zoom Area can be used to focus a viewer's attention by zooming in an important part of a video.
Zoom Area properties can be edited by clicking on the object in the Timeline or on the Canvas. In the Object
Inspector, you can rename the object, edit its size, shape, source and so on.

Name
The default name for a zoom area is 'Zoom Area X' ﴾'Zoom Area 1', 'Zoom Area 2', and so onward﴿, and
this is visible in the name property of the object. You can change the name by deleting the default name
and typing in another one.

1

Placement & Opacity
Adjust the size, rotational angle, scale or manually change the location of the zoom area on the Canvas.

Learn more...

Click the Reset button to reset all values.

Position

Enter X and Y coordinates to specify
the location in pixels of your object on
the canvas, based on the center of the
object.

Size Enter Width and Height to specify the
size in pixels of your object.

Rotation Use the rotation option to rotate ﴾in
degrees: ‐180 to180﴿ the object.

Scale Use the scale option to scale ﴾10% to
200%﴿ the object.

2

Shape
The shape property allows you to change the appearance of the object: Rectangle, Circle, Ellipse, Triangle,
Hexagon, Octagon.

Learn more...

3
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Adjust ﴾
Rectangle/Triangle﴿: Use
the slider to adjust the
roundness of the
corners.

Zoom Source
Select the area of the video that you want to magnify.

Learn more...

Zoom Use the slider to set the zoom value or
enter it manually ﴾100% to 500%﴿.

Center X Enter Center X ﴾‐100% to 100%﴿ based
on the center of the video.

Center Y Enter Center Y ﴾‐100% to 100%﴿ based
on the center of the video.

Rotation Use the rotation option to rotate ﴾in
degrees: ‐180 to180﴿ the source.

4

Effect
Set an effect: Gaussian Blur, Directional Blur, Colorize, Grayscale, Pixelate.

Learn more...

Use the slider to set the
intensity value or enter
it manually ﴾0 to 100%﴿.

5

Border
Add a border to object.

Learn more...

6
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See also
Screen recording
Image
Video
Audio
Shape
Text
Sketch animation
Video effect
Video transition
Text‐to‐speech
Voice over narration
 
 

Brush

Click to choose Solid Color | Linear
Gradient | Radial Gradient from the
popup menu.
For solid color, click the thumb and
select a color from the menu. Right
click on the thumb to set the opacity
﴾0 to 100%﴿.
For gradient, click in the left thumb
and select a color, then click in the
right thumb and select the second
color.

Style

Describes the sequence of dashes
and gaps: Solid, Dash, Dot, Dash Dot,
Dash Dot Dot.
Describes the shape at the end of a
line or segment: Flat, Square, Round,
Triangle.

Thickness The border width ﴾in pixels: 1 to 20﴿.

Offset In pixels: ‐50 to 50.

Blur Size The amount of blur to be applied to
the border ﴾in pixels: 0 to 20﴿.

Opacity

Use the slider to set the opacity value
or enter it manually ﴾0 to 100%﴿.
When set to zero, the border is
invisible.
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  Home > Configuring object properties > Video transition

Video transition
 
Video Transition properties can be edited by clicking on the object in the Timeline.
In the Object Inspector, you can set the transition.

See also
Screen recording
Image
Video
Audio
Shape
Text
Sketch animation
Video effect
Zoom area
Text‐to‐speech
Voice over narration

Name
The default name for a video transition is 'Video Transition  X' ﴾'Video Transition 1', 'Video Transition 2',
and so onward﴿, and this is visible in the name property of the object. You can change the name by
deleting the default name and typing in another one.

1

Transition
The following transitions are included: Custom In, Custom Out, Circle Open, Circle Close, Rectangle Open,
Rectangle Close, Reveal, Slide, Radial Blur, Spin Blur, Pixelate, Dissolve, Genie, Swirl, Magnify, Fisheye
Lens.

Learn more...

Click the Preview button to preview the transition on
the Canvas.
Click the Easing Function button to specify the rate
of change of a parameter over time.
Configure the transition properties ﴾Movement, Blur
Size, Scale, Fade, Spin, etc.﴿ using the controls
displayed on the bottom of the panel.

2
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  Home > Configuring object properties > Text‐to‐speech

Text‐to‐speech
 
Text‐to‐speech properties can be edited by clicking on the object in the Timeline.
In the Object Inspector, you can rename the object, edit its text.

Name
The default name is 'Text‐to‐Speech X' ﴾'Text‐to‐Speech 1', 'Text‐to‐Speech 2', and so onward﴿, and this is
visible in the name property of the object. You can change the name by deleting the default name and
typing in another one.

1

Text ‐ Microsoft Speech API

Learn more...

2
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Use the slider to set the rate value or enter it
manually ﴾‐10 to 10﴿.
Use the slider to set the volume value or enter
it manually ﴾0 to 100%﴿.
Click Convert to convert the text.

Text ‐ Google Cloud Text‐To‐Speech

Learn more...

3
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Use the slider to set the rate value or enter it manually ﴾25 to 400%﴿.
Use the slider to set the volume gain value or enter it manually ﴾‐10 to 10 dB﴿.
Click Convert to convert the text.

 

In the Cloud Console, on the project selector page, select or
create a Google Cloud project.

1

Make sure that billing is enabled for your Google Cloud
project.

2

Enable the Cloud Text‐to‐Speech API.3

Click the menu button and select APIs & Services >
Credentials.

4

On the Credentials page, click Create credentials > API key.5

The API key created dialog displays your newly created API
key.

6

The new API key is listed on the Credentials page under API
keys.

7

Volume Control4
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See also
Screen recording
Image
Video
Audio
Shape
Text
Sketch animation
Video effect
Zoom area
Video transition
Voice over narration
 
 
 

Learn more...

Use the slider to set the volume value or enter it
manually ﴾0 to 200%﴿.
Enter Fade In and Fade Out values to specify the
audio transitions ﴾in ms: 0 to 2000﴿.
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  Home > Configuring object properties > Voice over narration

Voice over narration
 
This object enables you to add a voiceover on top of an existing recording. The audio clip created appears on
the Timeline when the voice narration ends.
Voice over properties can be edited by clicking on the object in the Timeline.
In the Object Inspector, you can set the volume.

See also
Screen recording
Image
Video
Audio
Shape
Text
Sketch animation
Video effect
Zoom area
Video transition
Text‐to‐speech

Name
The default name for a voice over is 'Audio  X' ﴾'Audio 1', 'Audio 2', and so onward﴿, and this is visible in
the name property of the object. You can change the name by deleting the default name and typing in
another one.

1

Volume Control

Learn more...

Use the slider to set the volume value or enter it
manually ﴾0 to 200%﴿.
Enter Fade In and Fade Out values to specify the
audio transitions ﴾in ms: 0 to 2000﴿.

2
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  Home > Exporting your project

Exporting your project
 
The final task is to convert your project to a standard video format for distribution.
ScreenToVideo allows you to export your project in the following file formats:

MP4 ‐ H.264 encoder: encodes video in H.264 format with AAC audio
MP4 ‐ H.265 encoder: encodes video in HEVC format with AAC audio
WMV ‐ Windows Media Video
GIF ‐ animated GIF

 

 Use Export > Export Frame to export a screenshot from the position of the timeline playhead.

See also
Overview
Getting Started
Creating a new project
Recording media
Editing a project
Configuring object properties
 
 
 

Exporting your project . 89
 

ScreenToVideo



  Home > Exporting your project > Exporting your video

Exporting your video
 
Use Export > Export Project to produce a video file.
ScreenToVideo allows you to export your project in the following file formats:

MP4 ‐ H.264 encoder: encodes video in H.264 format with AAC audio
MP4 ‐ H.265 encoder: encodes video in HEVC format with AAC audio
WMV ‐ Windows Media Video
GIF ‐ animated GIF

 

Output File
Set the output file format.

Learn more...

Format

Click the dropdown to select:
MP4 ‐ H.264 Software/Hardware encoder encodes video in H.264 with AAC audio
WMV ‐ Windows Media Video
MP4 ‐ H.265 Software/Hardware encoder encodes video in HEVC with AAC audio
GIF ‐ Animated GIF

 Please be advised that HEVC is not a widely supported codec.

Name Enter the name of your video. The default name is the name of your project file. The file extension is applied
automatically based on your choice of Format.

Folder
icon

Navigate and select the location of your exported video file.

1

Time Range
Set a selection of the Timeline.

2
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See also

Learn more...

Check Selection to export a selection of
the timeline.
Enter Time Start and Time End values to
specify the selection.

Video
Configure your video export options.

Learn more...

Frame
rate

Available frame rates: 1, 5, 10, 20, 24, 25,
30, 48, 50, 60 frames per second.

Quality Use the slider to set the quality value or
enter it manually ﴾50 to 100%﴿.

Size

Click the drop‐down box and choose a
preset size or select the Custom Size
menu item to enter custom dimensions.
Click on the Project Size menu item to
export the video to the project size.

3

Audio
Configure your audio export options.

Learn more...

Check Include to export audio.
Click the dropdown Bit rate to specify the audio bit rate
﴾in Kbps: 96, 128, 160, 192﴿.

4
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Exporting a frame
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  Home > Exporting your project > Exporting a frame

Exporting a frame
 
To export a screenshot from the position of the timeline playhead, select Export > Export Frame.
 

 
ScreenToVideo allows you to export a frame in the following file formats:

Bitmap ﴾.bmp﴿
Portable Network Graphics ﴾.png﴿
GIF Image ﴾.gif﴿
JPEG Image ﴾.jpg﴿
TIFF Image ﴾.tif﴿
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